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Εκτελεστικού Οργανισμού για το Κλίμα, τις Υποδομές και το Περιβάλλον. Ούτε η Ευρωπαϊκή Ένωση ούτε η 
χορηγούσα αρχή μπορούν να θεωρηθούν υπεύθυνες γι' αυτές. 
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1 iCIM 

Διαδικασία συγχρονισμού iCIM 
Ο συγχρονισμός iCIM δημιουργήθηκε για να επιτρέψει τη σύνδεση με ένα υπάρχον έργο iCIM, ένα
μοντέλο iCD που περιέχει ήδη αντικείμενα. Αυτή η διαδικασία έχει ως στόχο να διευκολύνει το 
συγχρονισμό πολλών μοντέλων iCD σε ένα μόνο έργο iCIM. 

Άνοιγμα iCD 
1. Ανοίξτε το μοντέλο που αναπτύχθηκε στο iCD.
2. Επιλέξτε Extensions> IES iCD>IES iCIM Client>Advanced> Enable dangerous 

operations.
3. Άνοιγμα ιστοσελίδας iCIM: https://icim.iesve.com/trial/#/

4. Επιλέξτε Extensions IES iCD>IES iCIM Client>Advanced> Manage Endpoints

5. Κάντε κλικ στην επιλογή "Προσθήκη νέου", επικολλήστε τη διεύθυνση URL iCIM, αφαιρέστε
τον αστερίσκο και προσθέστε: /gfc/
Κάντε κλικ στο "Έλεγχος διεύθυνσης URL" και στη συνέχεια στο "Αποθήκευση".

https://icim.iesve.com/trial/#/
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6. Στη λίστα των τελικών σημείων (Endpoints) στην κύρια οθόνη, μπορούμε να κάνουμε "Εξαγωγή" για
εξαγωγή ολόκληρης της λίστας (θα δημιουργήσει ένα αρχείο GeoJSON). Αυτό μπορεί στη συνέχεια 
να εισαχθεί σε άλλους υπολογιστές. Είναι χρήσιμο για την κοινή χρήση έργων.
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7. Συγχρονίστε το μοντέλο με το iCIM. Πρέπει να κάνετε κλικ στο κουμπί Synchronize (πάνω

και κάτω βέλος) στη γραμμή εργαλείων iCD (μπορεί να ζητήσει έλεγχο ταυτότητας). Επιλέξτε 

το "location to sync". Κάντε κλικ στο "Add New", εισαγάγετε το όνομα και την περιγραφή σας 

και κάντε κλικ στο "Publish".

Σημείωση: στο κάτω μέρος, υπάρχει ένα σημάδι επιλογής που επιτρέπει τη μερική 
μεταφόρτωση του μοντέλου.

8. Επιλέξτε ένα κτίριο ή μια περιοχή στο μοντέλο για να το προβάλετε στο iCIM. Το iCD

επιτρέπει τώρα στους χρήστες να συγχρονίζουν μόνο ένα μέρος του μοντέλου iCD που 
βρίσκεται εντός μιας περιοχής "area of interest" (AOI). Το AOI είναι μια γεωγραφική ζώνη 
που μπορεί να οριστεί στο iCD. Η διαδικασία συγχρονισμού iCIM μπορεί να περιορίσει το 
συγχρονισμό μόνο σε αντικείμενα μέσα σε ένα AOI. Αυτό μπορεί να είναι ιδιαίτερα χρήσιμο 
για το συγχρονισμό πολλών διαφορετικών μοντέλων iCD (που καλύπτουν διαφορετικές 
γεωγραφικές περιοχές) σε ένα ενιαίο έργο iCIM ή εάν πολλοί χρήστες επεξεργάζονται και 
συγχρονίζουν ανεξάρτητα συγκεκριμένα μέρη ενός μοντέλου iCD. Για να χρησιμοποιήσετε 
ένα AOI για να συγχρονίσετε ένα μοντέλο, είναι πρώτα απαραίτητο να το δημιουργήσετε σε 
iCD. Για να δημιουργήσετε ένα AOI:
Κάντε δεξί κλικ στο κτίριο για να επιλέξετε> IES iCD> Area of interest>Add Selected
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9. Τώρα, για να προσθέσετε, είναι απαραίτητο να αποσυνδεθείτε από το iCIM στο
Extension>iCD>IES iCIM Client>Advanced> Clear all Settings.

Κάντε κλικ στο διπλό βέλος και δημιουργήστε ένα νέο έργο. Προκειμένου η διαδικασία 
συγχρονισμού να λαμβάνει υπόψη μόνο τις αλλαγές που συνέβησαν εντός του AOI, το 
πλαίσιο Limit to the buildings inside the baseline Area of Interest, πρέπει να είναι 
επιλεγμένο.

Άνοιγμα iCIM 
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Ανοίξτε το iCIM (https://icim.iesve.com/trial/#/). Κάνοντας κλικ στο σύμβολο iCIM στο 
επάνω αριστερό μέρος της οθόνης, μπορείτε να αποκτήσετε πρόσβαση στον Οδηγό χρήσης, 
ο οποίος είναι ο ηλεκτρονικός οδηγός iCIM. 

Κάνοντας κλικ στις τέσσερις γραμμές στο κουμπί στα δεξιά "Open" μπορώ να: 

1. Μετονομάσω το επιλεγμένο έργο.
2. Διαγράψω το έργο, το οποίο πηγαίνει στη σελίδα διαγραφής και από εκεί μπορώ να το 

διαγράψω μόνιμα ή ακόμα και να το ανοίξω.
3. Κάνω το έργο δημόσιο ή προσθέσωάτομα στο έργο και μπορώ να δώσω προνόμια μέσω 

της "Διαχείρισης χρηστών".
4. Δημοσιεύσω μέσω της "Δημοσίευσης", ώστε όλοι να μπορούν να το δουν.
5. Ανοίξω το έργο μέσω του "Άνοιγμα" και ανοίγει η σελίδα υποδοχής. Εξηγεί τους τρόπους 

με τους οποίους είναι δυνατή η μετακίνηση στο μοντέλο.

Παρακάτω ένα παράδειγμα για να εξηγήσει τη διεπαφή. 

https://icim.iesve.com/trial/#/
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- Κάτω 2021 είναι η περίοδος συγχρονισμού σεναρίου
- Πάνω, ο ήλιος δημιουργεί σκιές των κτιρίων.
- Η κάμερα χρησιμοποιείται για την αποθήκευση προβολών
- Το "layer button" είναι να δείτε τα διάφορα στρώματα του iCD
- "Φίλτρο" για να φιλτράρετε το μοντέλο με βάση ορισμένες συνθήκες. Αν θέλω, μπορώ 

να επιλέξω πολλά φίλτρα ταυτόχρονα.
- Ανάλυση που χρωματίζει τα κτίρια με βάση τις μετρήσεις. Είναι δυνατή η αλλαγή των 

ελάχιστων και μέγιστων τιμών που μπορούν να εμφανιστούν. Με τη "Metrics 
Comparison", είναι δυνατή η σύγκριση των διαφορετικών σεναρίων που 
προσομοιώθηκαν στο iCD.

Μπορείτε να κάνετε κλικ σε ένα μόνο κτίριο και να διερευνήσετε τα αποτελέσματα για 
αυτό το κτίριο. Στα "Attributes" είναι επίσης δυνατό να κάνετε κλικ στο "Edit". Αυτό 
συμβαίνει σε περίπτωση που έκανα μια μικρή αλλαγή στο μοντέλο και δεν θέλω να 

ανεβάσω ολόκληρο το μοντέλο στο iCIM.   

Εισαγωγή μοντέλου iCIM στο iVN 
Ανοίξτε το iVN και κάντε κλικ στην αριστερή γραμμή στο Import > iCIM link. Βάλτε τον σύνδεσμο 
(https://icim.iesve.com/trial/gfc/) και συνδεθείτε στο IES. Τα έργα θα εμφανιστούν παρακάτω. 
Επιπλέον, παρακάτω, είναι δυνατό να υποδείξετε τις ημερομηνίες έναρξης και λήξης των 

https://icim.iesve.com/trial/gfc/
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προσομοιώσεων που θέλετε να εισαγάγεται  Τέλος, μπορείτε να εισαγάγετε όλα τα δεδομένα από 
το επιλεγμένο μοντέλο. 

2 iVN 

Ρύθμιση iVN 
Αφού δημιουργήσετε έναν λογαριασμό με το iVN, πρέπει να συνδεθείτε στον λογαριασμό σας για να 
αποκτήσετε πρόσβαση στο εργαλείο.  

Μετά την εκκίνηση του iVN, θα ανοίξει ένα παράθυρο του προγράμματος περιήγησης κατευθύνοντας 
τον χρήστη στη σελίδα σύνδεσης. Συνδεθείτε στην πλατφόρμα SSO μέσω του προγράμματος 
περιήγησης εισάγοντας τα διαπιστευτήρια λογαριασμού. Εάν δεν έχετε ήδη λογαριασμό, θα πρέπει 
να επιλέξετε το κουμπί "Sign Up Now" και θα πρέπει να δημιουργήσετε ένα νέο κωδικό πρόσβασης 
μαζί με την εισαγωγή της διεύθυνσης ηλεκτρονικού ταχυδρομείου σας.  

Σημείωση: Η ίδια διεύθυνση ηλεκτρονικού ταχυδρομείου που έχει εκχωρηθεί στην αρχική άδεια 
iVN πρέπει να επαναχρησιμοποιηθεί εδώ. Μια νέα διεύθυνση ηλεκτρονικού ταχυδρομείου δεν θα 
γίνει αποδεκτή.  

Νέο Έργο 
Όταν ανοίγετε το iVN για πρώτη φορά, σας καλωσορίζει η αρχική σελίδα "Homepages" του iVN. 
Αυτές οι "Homepages" παρέχουν χρήσιμους συνδέσμους σε πρόσθετους πόρους και εκπαιδευτικό 
υλικό μαζί με την πιο ενημερωμένη έκδοση του λογισμικού (συμπεριλαμβανομένων ειδοποιήσεων 
για διαθέσιμες ενημερώσεις).  
Για να ξεκινήσετε ένα νέο έργο από τις "Homepages", κάντε κλικ στην καρτέλα "new" που βρίσκεται 
στην αριστερή στήλη της καρτέλας. Αυτό θα ανοίξει ένα κενό έργο από όπου μπορείτε να 
ξεκινήσετε να δημιουργείτε την προσομοίωση δικτύου σας. Το κενό έργο ανοίγει τον τρισδιάστατο 
χώρο σχεδίασης όπου μπορείτε να αρχίσετε να σχεδιάζετε ή να εισάγετε φυσικά την υποδομή που 
απαιτείται για τη ρύθμιση του δικτύου σας. 
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Προβολή μοντέλων 3D 
Το πρόγραμμα προβολής μοντέλων 3D σάς δίνει τη δυνατότητα να σχεδιάσετε κτίρια/υποδομές για 
χρήση εντός της προσομοίωσης ΤΟΥ δικτύου. 

2.3.1 Σχεδίαση δομών 
Για να ξεκινήσετε τη λειτουργία σκίτσου, επιλέξτε το εικονίδιο "Draw line" από τη γραμμή 
εργαλείων. Το εργαλείο «Draw line» θα σχεδιάσει γραμμές κατά μήκος του επιλεγμένου επιπέδου 
χρησιμοποιώντας τα καθορισμένα σημεία που επιλέγονται από το εργαλείο. Λειτουργεί 
εντοπίζοντας την περίμετρο της κάτοψης στον καμβά. Με το μεσαίο κουμπί του ποντικιού, 
μπορείτε να μετατοπίσετε την προβολή για να διευκολύνετε τη σχεδίαση της γραμμής.  

2.3.2 Εισαγωγή από το OpenStreetMap 
Από την οθόνη "Welcome screen", η επιλογή "Homepages" για την εισαγωγή κτιρίων 
από το OpenStreetMap είναι διαθέσιμη από την καρτέλα εισαγωγής.  Εντοπίστε τη συγκεκριμένη 
περιοχή που θέλετε να εισαγάγετε για το δίκτυό σας χρησιμοποιώντας το OpenStreetMap. 

Επισημάνετε την επιθυμητή υποδομή χρησιμοποιώντας τη λειτουργία κλικ και μεταφοράς για να 
επιλέξετε τη συγκεκριμένη περιοχή για εισαγωγή (εναλλακτικά εργαλεία επισήμανσης είναι 
διαθέσιμα στην αριστερή γωνία). Μόλις επιλεγεί η επιθυμητή περιοχή, εισαγάγετε τα δεδομένα 
κάνοντας κλικ στο «Import data» στην κάτω δεξιά γωνία της καρτέλας. 
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Πλοηγηθείτε στη διεπαφή 
Τα τρία κύρια στοιχεία της διεπαφής είναι ο επιθεωρητής δεδομένων (Data Inspector), ο κόμβος 
προσομοίωσης  (Simulation Hub) και ο επιθεωρητής ανάλυσης(Analysis Inspector).  

2.4.1 Επιθεωρητής δεδομένων (Data Inspector) 
Ο επιθεωρητής δεδομένων είναι η κύρια μέθοδος εισαγωγής δεδομένων και παραμέτρων στο 
δίκτυο. Κάντε κλικ σε ένα στοιχείο εντός του δικτύου είτε κάνοντας φυσικό κλικ στο εικονίδιο στο 
πρόγραμμα προβολής έργου είτε επιλέγοντάς το από τη λίστα στο πρόγραμμα περιήγησης έργου. Οι 
παράμετροι των περιουσιακών στοιχείων μπορούν στη συνέχεια να εισαχθούν για το συγκεκριμένο 
δίκτυο.  
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2.4.2 Κέντρο προσομοίωσης (Simulation Hub) 
Το "Simulation Hub" περιέχει τις παραμέτρους εισόδου για τις προδιαγραφές της επιδιωκόμενης 
προσομοίωσης του δικτύου. Εδώ καθορίζονται το μήκος, τα διαστήματα αναφοράς και τα χρονικά 
βήματα της επιδιωκόμενης προσομοίωσης. Κάνοντας κλικ στο κουμπί "Simulate" ξεκινά η 
προσομοίωση.  

Σημείωση: Για να εκτελέσετε μια προσομοίωση, το δίκτυο πρέπει να επιλεγεί στο πρόγραμμα 
περιήγησης του έργου.  

2.4.3 Επιθεωρητής ανάλυσης  (Analysis Inspector)
Μόλις ολοκληρωθεί μια προσομοίωση, τα αποτελέσματα είναι προσβάσιμα μέσω του επιθεωρητή 
ανάλυσης. Από τον επιθεωρητή ανάλυσης ο χρήστης μπορεί να καθορίσει το συγκεκριμένο σύνολο 
αποτελεσμάτων που επιθυμεί να δει επιλέγοντάς τα από το αναπτυσσόμενο μενού και στη 
συνέχεια καθορίζοντας την επιθυμητή μέθοδο αναπαράστασης από το «Table chart», το «ΓLine 
chart» ή το «Bar chart» όπως φαίνεται παρακάτω.  

Εικονικό δίκτυο 
Οι εικονικοί κόμβοι δικτύου χρησιμοποιούνται στο iVN για να αντιπροσωπεύουν ομάδες στοιχείων 
και, όταν συνδέονται μεταξύ τους, ορίζουν μια ιεραρχία προσφοράς με τη μορφή δέντρου. 
Δημιουργήστε μια προβολή εικονικού δικτύου 2D κάνοντας κλικ στο εικονίδιο "συν (+)" στην 
επάνω αριστερή γωνία του "Project viewer". 
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Από εδώ, πολλαπλές προβολές και σενάρια μπορούν να χρησιμοποιηθούν για την παροχή 
εναλλακτικών προβολών του έργου. Για να δημιουργήσετε πολλαπλά σενάρια / εικονικές / φυσικές 
προβολές δικτύου, κάντε δεξί κλικ στο δίκτυο που βρίσκεται στο "Object Browser" και επιλέξτε 
"Open in new virtual network view". 

2.5.1 Δημιουργία εικονικού δικτύου 
Από την καρτέλα βιβλιοθήκης διαθέσιμων στοιχείων που βρίσκεται στα δεξιά του προγράμματος 
προβολής έργου, τα στοιχεία μπορούν να προστεθούν σύροντας και αποθέτοντας απευθείας στο 
πρόγραμμα προβολής εικονικού δικτύου. 

Ομοίως, όταν χρησιμοποιείτε εισαγόμενα κτίρια, τα στοιχεία μπορούν να επιλεγούν από τη 
βιβλιοθήκη διαθέσιμων στοιχείων και να μεταφερθούν απευθείας στο χώρο του έργου (προβολή 
εικονικού δικτύου).  
Ο επιθεωρητής δεδομένων θα απαριθμήσει κάθε κτίριο που έχει 3D γεωμετρία που σχετίζεται με 
αυτό κάτω από τη στήλη "3D geometry". Η μεταφορά και απόθεση ενός κτιρίου από το εργαλείο 
επιθεώρησης δεδομένων στην προβολή εικονικού δικτύου θα το προσθέσει στο εικονικό δίκτυο, 
μαζί με την κάτοψή του. Εάν η γεωμετρία 3D δεν είναι διαθέσιμη για ένα κτίριο, τότε το κτίριο 
μπορεί να προστεθεί σύροντας και αποθέτοντας το στοιχείο "Building" από τη βιβλιοθήκη πόρων. 
Εάν η γεωμετρία 3D γίνει διαθέσιμη αργότερα για ένα κτίριο μετά την προσθήκη του στοιχείου 
"Building" στην εικονική προβολή, τότε η μεταφορά και απόθεση του κτιρίου που αναφέρεται στην 
ενότητα "Geometry 3D" στο εργαλείο επιθεώρησης δεδομένων σε ένα υπάρχον εικονίδιο κτιρίου 
στην προβολή εικονικού δικτύου θα συσχετίσει αυτήν τη γεωμετρία με το στοιχείο κτιρίου, 
αντικαθιστώντας το εικονίδιο με την κάτοψη του κτιρίου και μεταφέροντάς το στη γεωγραφική του 
θέση. 

Για τον ορισμό ενός εικονικού δικτύου, τα περιουσιακά στοιχεία συνδέονται με κόμβους που 
αντιπροσωπεύουν τα εμπορεύματα (κόμβος ηλεκτρικής ενέργειας, κόμβος ψύξης, κόμβος 
θερμότητας, κόμβος πόσιμου νερού, κόμβος λυμάτων) που παράγονται ή καταναλώνονται. Οι 
κόμβοι μπορούν επίσης να συνδεθούν με άλλους κόμβους για να αντιπροσωπεύουν διαφορετικά 
"επίπεδα" όπου συγκεντρώνεται η ζήτηση.  

2.5.2 Ρύθμιση εικονικού δικτύου 
Για να δημιουργηθεί ένα εικονικό δίκτυο, πρέπει να προστεθούν μεμονωμένοι κόμβοι στο δίκτυο. 
Κάθε κόμβος εντός του δικτύου λειτουργεί ως σημείο συνάθροισης επιτρέποντας στο δίκτυο να 
επιθεωρηθεί και να αναλυθεί σε διάφορα επίπεδα. Συνδέοντας κόμβους του ίδιου τύπου μεταξύ 
τους, ορίζεται μια ιεραρχία δέντρου. Σε κάθε κόμβο του δέντρου, η ζήτηση συγκεντρώνεται από 
όλα τα συνημμένα περιουσιακά στοιχεία και αυτή η ζήτηση ικανοποιείται, όσο το δυνατόν 
περισσότερο, από τυχόν συνδεδεμένες γεννήτριες. Τυχόν υπολειπόμενη ζήτηση μεταβιβάζεται στη 
συνέχεια στον επόμενο κόμβο της ιεραρχίας, όπου περιλαμβάνεται στη συνάθροιση ζήτησης για 
αυτόν τον κόμβο. Αυτός ο υπολογισμός υπολογίζεται με τη σειρά, ξεκινώντας από τα "leaves" του 
δέντρου και συνεχίζοντας μέχρι τον κόμβο "root". Κάθε ζήτηση που δεν καλύπτεται στον ριζικό 
κόμβο θεωρείται ότι παρέχεται από εξωτερική προσφορά. Έτσι, είναι σημαντικό με ποιον τρόπο 
κάνουμε τις 
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συνδέσεις. Οι κόμβοι εκκίνησης έχουν την υψηλότερη ιεραρχία και είναι τα σημεία εκκίνησης της 
ροής. Δείτε την παρακάτω εικόνα. 

Τα διαθέσιμα στοιχεία μπορούν να συνδεθούν με κόμβους κάνοντας αριστερό κλικ στον μικρό 
κύκλο στο κέντρο του κόμβου ή κάτω από ένα στοιχείο και σύροντας μια γραμμή σύνδεσης. Οι 
έγχρωμοι κύκλοι κάτω από τα στοιχεία υποδεικνύουν τον τύπο κόμβου στον οποίο μπορεί να 
συνδεθεί το στοιχείο. Για παράδειγμα, ένας κόκκινος κύκλος υποδεικνύει ότι ένα στοιχείο μπορεί 
να συνδεθεί με έναν κόμβο θερμότητας. Εάν ο μικρός κύκλος κάτω από ένα στοιχείο είναι λευκός, 
π.χ. για κτίρια, τότε το στοιχείο μπορεί να έχει συνδέσεις 1 προς πολλά με πολλούς διαφορετικούς 
τύπους κόμβων. Ωστόσο, ένα στοιχείο μπορεί να έχει μόνο μία σύνδεση με έναν κόμβο 
συγκεκριμένου τύπου.  

Οι παράμετροι για κάθε μεμονωμένο στοιχείο μπορούν να οριστούν κάνοντας κλικ στο στοιχείο και 
χρησιμοποιώντας το εργαλείο επιθεώρησης δεδομένων. Τα προφίλ ζήτησης και παραγωγής 
μπορούν στη συνέχεια να οριστούν για συγκεκριμένα εμπορεύματα ανοίγοντας τον «Demand and 
generation editor" (αποκτήστε πρόσβαση στον επεξεργαστή κάνοντας διπλό κλικ στο διαθέσιμο 
στοιχείο / δεξί κλικ και επιλέγοντας «Set demand and generation»). Ο διάλογος αυτός είναι 
διαθέσιμος για κτίρια και γενικές εγκαταστάσεις. 

Μόλις κατασκευαστεί το επιθυμητό δίκτυο και όλες οι παράμετροι εισαχθούν σωστά, μπορεί να 
διεξαχθεί μια προσομοίωση δικτύου. 

2.5.3 Προσομοίωση δικτύου 
Μόλις ρυθμιστεί σωστά το δίκτυο, επιλέξτε το δίκτυο ως σύνολο στο πρόγραμμα περιήγησης έργου. 
Βεβαιωθείτε ότι οι παράμετροι δικτύου είναι σωστές χρησιμοποιώντας το εργαλείο επιθεώρησης 
δεδομένων. Ορίστε τις επιθυμητές παραμέτρους προσομοίωσης δικτύου στην καρτέλα διανομέα 
προσομοίωσης: 
• Ημερομηνία έναρξης: ΗΗ/ΜΜ/ΕΕΕΕ 00:00-23:59
• Ημερομηνία λήξης: ΗΗ/ΜΜ/ΕΕΕΕ 00:00-23:59
• Χρονικό βήμα: 1-60
• Διάστημα αναφοράς: X ≥ Χρονικό βήμα
• Προτιμήσεις σφαλμάτων και προειδοποιήσεων.
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Τώρα μπορείτε να κάνετε κλικ στο "Simulate". Τα αποτελέσματα, όταν ολοκληρωθεί η εκτέλεση της 
προσομοίωσης, μπορούν να προβληθούν μέσω του "Analysis inspector".

Φυσικό δίκτυο 
Για να προσθέσετε στοιχεία στο φυσικό δίκτυο, πρέπει πρώτα να υπάρχουν στο εικονικό δίκτυο. 
Μόλις εμφανιστούν στο εικονικό δίκτυο, τα διαθέσιμα στοιχεία μπορούν στη συνέχεια να 
προστεθούν στο φυσικό δίκτυο κάνοντας δεξί κλικ και «Προσθήκη στο φυσικό δίκτυο (Add to 
physical network)». Για να δημιουργήσετε ένα φυσικό δίκτυο, πρέπει να υπάρχουν πρόσθετες 
πρόσθετες άδειες χρήσης:

Θερμότητα:        :Mοντελοποίηση του δικτύου τηλεθέρμανσης επιτρέπει την αξιολόγηση του σχεδιασμού 
της θερμικής ενέργειας από την άποψη της υποδομής δικτύου και εάν απαιτούνται αλλαγές ή 
αναβαθμίσεις. 

Βελτιστοποίηση:         : Ένα πρόβλημα βελτιστοποίησης μπορεί να δημιουργηθεί καθορίζοντας τον/τους 
στόχο/-ους (π.χ. ελαχιστοποίηση των εκπομπών άνθρακα), μεταβλητές και περιορισμούς ώστε να 
παρέχεται αυτόματα το βέλτιστο μέγεθος όλων των περιουσιακών στοιχείων στο σχεδιασμό που 
ικανοποιούν την ενεργειακή ζήτηση. 

Συνάρτηση εισαγωγής 
Η καρτέλα εισαγωγής «Import» που βρίσκεται στις αρχικές σελίδες«Homepages» παρέχει στον 
χρήστη διάφορες επιλογές για την εισαγωγή δεδομένων στο iVN.

2.7.1 Σύνδεσμος iCIM 
Εισαγάγετε ένα μοντέλο από το iCIM φορτώνοντας τη συγκεκριμένη διεύθυνση URL του έργου. 
Εισαγωγή από επιλεγμένη και καθορισμένη ημερομηνία έναρξης και λήξης. Είναι σημαντικό να 
σημειωθεί ότι το τελικό σημείο iCIM που πρέπει να αντιγραφεί και να επικολληθεί στην ενότητα 
εισαγωγής που φαίνεται παρακάτω είναι το εξής: https://icim.iesve.com/iesiclprojects/cim/project.

Μόλις γίνει αυτό, θα εμφανιστεί μια προτροπή για την εισαγωγή στοιχείων σύνδεσης iCIM. Από εκεί, 
λοιπόν, η λίστα των έργων iCIM θα είναι επιλέξιμη σε μορφή λίστας. Ένα έργο μπορεί να επιλεγεί από 
τη λίστα και στη συνέχεια γίνεται κλικ στο κουμπί "Viewer" και θα εμφανιστεί ένα αναδυόμενο 
παράθυρο που θα δείξει την περιοχή που καταγράφηκε από το έργο iCIM. Στη συνέχεια, υπάρχει μια 
επιλογή είτε να επιλέξετε μια περιοχή ενδιαφέροντος για εισαγωγή με τον ίδιο τρόπο που γίνεται για 
την εισαγωγή OSM, είτε ολόκληρη η περιοχή μπορεί να εισαχθεί. 

Σύνδεσμος iSCAN 
Το iSCAN μπορεί να χρησιμοποιηθεί για την εισαγωγή μετρημένων δεδομένων χρονοσειρών ή για τη 
δημιουργία δεδομένων συγκριτικής αξιολόγησης κτιρίων. Για την εισαγωγή δεδομένων 
χρονοσειρών, απαιτείται η αντιγραφή και επικόλληση των συνδέσεων διακριτικού API έργου και API 
έργου. Μόλις γίνει αυτό, συνδεθείτε στον λογαριασμό iSCAN μέσω του αναδυόμενου διαλόγου. Στη 
συνέχεια, θα εμφανιστεί μια λίστα καναλιών και μπορεί να επιλεγεί για την εισαγωγή δεδομένων 
μεταξύ των ημερομηνιών που ορίζονται στην κάτω δεξιά γωνία. 

Για να δημιουργήσετε το διακριτικό iSCAN API και να λάβετε τη διεύθυνση URL του έργου, συνδεθείτε 
στο iSCAN και μεταβείτε στο επιθυμητό έργο και επιλέξτε "API tokens" στο μενού στα δεξιά της 
οθόνης. Κάντε κλικ στην επιλογή "Create token" στην επόμενη οθόνη και κατά τη δημιουργία του 
βεβαιωθείτε ότι η ημερομηνία λήξης είναι αρκετά μεγάλη στο μέλλον που είναι κατάλληλη και ότι 
έχει επιλεγεί ο ρόλος "Operator". Η εισαγωγή δεν θα λειτουργήσει εάν αυτές οι επιλογές είναι 
εσφαλμένες. Μόλις δημιουργηθεί, ο σύνδεσμος διακριτικού API προς την κορυφή και 



 STEP-WISE GA Ν. 101120859 ΣΕΛΙΔΑ 18 

ΟΔΗΓΊΕΣ ΠΕΡΊΠΤΩΣΗΣ ΧΡΉΣΗΣ ΤΗΣ ΤΕΧΝΙΚΉΣ ΕΡΓΑΛΕΙΟΘΉΚΗΣ 16.12.2024 - ΤΕΛΙΚΗ ΕΚΔΟΣΗ 

η διεύθυνση URL του έργου στο κάτω μέρος της οθόνης μπορούν να αντιγραφούν και να 
επικολληθούν στο iVN όπως περιγράφηκε προηγουμένως.  

2.8.1 Εισαγωγή CSV 
Δυνατότητα εισαγωγής προφίλ χρονοσειρών σε μορφή csv στο iVN. Οι χρονοσειρές μπορούν να 
χρησιμοποιηθούν από το σύστημα και να οριστούν ως προφίλ στις μονάδες ζήτησης και προσφοράς. 
Όταν επιλέγετε ένα συγκεκριμένο σύνολο δεδομένων χρονοσειρών σε μορφή CSV, η δομή των 
χρονοσειρών πρέπει να επιλέγεται από το αναδυόμενο μενού και να εισάγεται στην κατάλληλη 
μορφή ("Row per profil" ή "Column per profile"). 

Η δομή "Row per profil" φαίνεται παρακάτω. 

Η δομή "Column per profil" φαίνεται παρακάτω. 

Μόλις εισαχθούν τα προφίλ, είναι διαθέσιμα για να καθοριστούν ως δεδομένα χρονοσειρών για 
διαθέσιμα στοιχεία ζήτησης/προσφοράς εντός ενός δικτύου iVN.  
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Κάνοντας διπλό κλικ στο επιθυμητό περιουσιακό στοιχείο ή κάνοντας δεξί κλικ στο στοιχείο και 
επιλέγοντας ορισμό ζήτησης και παραγωγής «set demand and generation», μπορεί να προστεθεί 
ένα προφίλ και να οριστούν οι παράμετροι για την προβλεπόμενη χρήση του στον επεξεργαστή 
ζήτησης και παραγωγής "Demand and generation editor.  

2.8.2 Δεδομένα καιρού 
Οι προσομοιώσεις iVN Energy απαιτούν δεδομένα καιρού αναφοράς για τη θέση του κτιρίου. Ένα 
σύνολο τυποποιημένων αρχείων καιρού προσομοίωσης περιλαμβάνεται στην εγκατάσταση iVN ή 
μπορεί να διαβάσει οποιοδήποτε αρχείο καιρού προσομοίωσης *.fwt ή *.epw. Οι πόροι 
παρέχονται εδώ για να δώσουν διαδρομές για την απόκτηση πρόσθετων αρχείων καιρού που 
μπορούν να χρησιμοποιηθούν σε προσομοιώσεις.  

Για να φορτώσετε ένα αρχείο καιρού από το σύνολο εγκατάστασης, κάντε κλικ στο "Homepages" 

> Import  >>Weather Data και, στη συνέχεια, κάντε κλικ στο εικονίδιο Αναζήτηση. Πρέπει να 
οριστούν παράμετροι τοποθεσίας μοντέλου (γεωγραφικό πλάτος, γεωγραφικό μήκος, υψόμετρο και 
ζώνη ώρας). Αυτό εξετάζει αρχικά τυχόν αρχεία που είναι αποθηκευμένα μέσα στο φάκελο αρχείων 
καιρού iVN, αλλά μπορείτε να περιηγηθείτε σε ένα νέο αρχείο που έχετε αποθηκεύσει οπουδήποτε 
αλλού στον τοπικό σας υπολογιστή. Όταν οριστεί το επιθυμητό αρχείο, μπορείτε στη συνέχεια να 
κάνετε κλικ στην επιλογή Εισαγωγή για να το φέρετε στο έργο έτοιμο για προσομοίωση.

3 iSCAN 

Εγκατάσταση έργου 

3.1.1 Λεπτομέρειες κτιρίου 
Η  σελίδα Building>>Building details χρησιμοποιείται για την επεξεργασία πληροφοριών σχετικά με 
το έργο, όπως όνομα, περίοδος δείγματος, ζώνη ώρας κ.λπ. Εδώ προστίθενται επίσης η τοποθεσία 
και το υψόμετρο της τοποθεσίας. Αυτές οι πληροφορίες μπορούν να χρησιμοποιηθούν για τη λήψη 
μετεωρολογικών δεδομένων για την τοποθεσία του ιστότοπου.  

3.1.2 Καιρός  
Μόλις η τοποθεσία και το υψόμετρο της τοποθεσίας εισαχθούν στη σελίδα Building details 
>Building, ενδέχεται να ληφθούν τα δεδομένα καιρού. Αυτό γίνεται από τη σελίδα δεδομένα  Data> 
Weather page. 

Επισημάνετε τις ημερομηνίες για τα απαιτούμενα έτη και επιλέξτε Συμπλήρωση δεδομένων 
ιστορικού. Μόλις συμπληρωθούν, αυτά τα δεδομένα θα είναι διαθέσιμα στο έργο iSCAN. 

Για να ενεργοποιήσετε τις αυτόματες ενημερώσεις δεδομένων καιρού, επιλέξτε το πλαίσιο ελέγχου 
Ενεργοποίηση αυτόματων ενημερώσεων καιρού. Οι μετεωρολογικές προβλέψεις μπορούν επίσης 
να ενεργοποιηθούν εδώ για μέγιστο διάστημα 5 ημερών, εισάγοντας τον αριθμό των ημερών 
πρόβλεψης. 

https://www.iesve.com/support/ivn/weatherfiles
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Εισαγωγή δεδομένων 
Τα δεδομένα μπορούν να εισαχθούν μέσω της  καρτέλας εισαγωγής δεδομένων  Data>Import
 για μια σειρά μορφών, όπως: 

• Μη αυτόματες εισαγωγές (CSV, XML)
• Αυτοματοποιημένες εισαγωγές ((SCAN Robot, συνδέσεις υπηρεσιών ιστού, αποκλειστικές

συνδέσεις IoT π.χ. MQTT, LoraWAN κ.λπ.)

Ρυθμίσεις καναλιού 
Μόλις εισαχθούν τα δεδομένα στο iSCAN, θα είναι διαθέσιμα ως κανάλια και εμφανίζονται στη 
σελίδα Data> Channel list page. Κάθε κανάλι αντιπροσωπεύει ένα σύνολο δεδομένων που περιέχει 
δεδομένα χρονοσειρών. 

Τα κανάλια θα είναι πάντα ορατά στην αριστερή πλευρά της οθόνης. Όταν επιλέγεται ένα κανάλι, οι 
πληροφορίες σχετικά με αυτό το κανάλι θα είναι διαθέσιμες στα δεξιά. 

Στην καρτέλα ρύθμιση καναλιού"Channel setting tab", ενδέχεται να προστεθούν πληροφορίες σε 
κάθε κανάλι για να δοθεί μεγαλύτερη σημασία στα δεδομένα καναλιού. Αυτό περιλαμβάνει; Το 
όνομα καναλιού, οι μονάδες, ο τύπος δείγματος, οι ελάχιστες και μέγιστες τιμές και οι επιλογές 
εξαγωγής. Οι σημειώσεις μπορούν επίσης να προστεθούν σε κανάλια για την ανταλλαγή 
πληροφοριών με άλλους χρήστες του έργου.  

3.3.1 Προσθήκη ετικετών σε κανάλια 
Η προσθήκη ετικετών στα κανάλια επιτρέπει στο χρήστη να δώσει περισσότερο νόημα στα δεδομένα 
του καναλιού και να οργανώσει το έργο iSCAN όπως επιθυμεί. Μπορείτε να προσθέσετε ετικέτες 
από τη  σελίδα Project > Tag Vocabularies. Μόλις δημιουργηθεί ένα λεξιλόγιο ετικετών, οι ετικέτες 
μπορούν να προστεθούν στο λεξιλόγιο. Οι ετικέτες μπορούν να εφαρμοστούν σε κανάλια από τη 
σελίδα  Data>Channel List page. 

3.3.2 Εκφράσεις 
Οι εκφράσεις επιτρέπουν τη χρήση μαθηματικών συναρτήσεων για την εξαγωγή εικονικών καναλιών 
από μετρημένα κανάλια δεδομένων στο πλαίσιο του έργου iSCAN. Οι εκφράσεις iSCAN 
χρησιμοποιούν τη δική τους σύνταξη, η οποία με περισσότερες λεπτομέρειες είναι διαθέσιμες στο 
iSCAN, από τη σύνδεση Σύνταξη στην καρτέλα Ρυθμίσεις καναλιών.  

Στο έργο επίδειξης υπάρχουν ήδη μερικά παραδείγματα ρύθμισης καναλιών με τη χρήση εκφράσεων. 
Αυτά είναι;  

• Συνολική ηλεκτρική ενέργεια:

Αυτό το κανάλι χρησιμοποιεί μια απλή έκφραση, αθροίζοντας την ηλεκτρική ενέργεια που 
μετράται από τα τρία υπο-μετρητές ηλεκτρικής ενέργειας εντός του κτιρίου.  

'Μετρητής Ηλεκτρικής Ενέργειας 1'+'Μετρητής Ηλεκτρικής Ενέργειας 2'+'Μετρητής Ηλεκτρικής 
Ενέργειας 3'  

Αυτό είναι χρήσιμο σε περιπτώσεις όπου ορισμένες περιοχές ενός κτιρίου μετρώνται, αλλά όχι 
όλες. Αντί της εγκατάστασης πρόσθετων μετρητών, μπορούν να χρησιμοποιηθούν εκφράσεις για 
την εξαγωγή "εικονικών μετρητών" από υπάρχοντα δεδομένα εντός του κτιρίου.  

• Άνοιγμα παραθύρου:
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Αυτό το κανάλι χρησιμοποιεί μια έκφραση για τον υπολογισμό ενός προφίλ για ανοίγματα 
παραθύρων με βάση τη θερμοκρασία του εξωτερικού αέρα και τις ώρες πληρότητας.  

Κτίριο.'Κατειλημμένες ώρες' == 1 και μέση τιμή (Καιρός.'Θερμοκρασία ξηρού βολβού', 2 
ώρες)>14; 1 : 0.01  

Αυτό σημαίνει ότι, όταν το κτίριο είναι κατειλημμένο και όταν η εξωτερική θερμοκρασία ξηρού 
βολβού είναι μεγαλύτερη από 14°C για περισσότερο από 2 ώρες, το παράθυρο είναι ανοιχτό. 
Εκτός των περιόδων κατοχής, χρειάζεται μια τιμή 0,01 για να ληφθεί υπόψη η διαρροή όταν τα 
παράθυρα είναι κλειστά.  

Εργαλείο οπτικοποίησης 

Μπορείτε να αποκτήσετε πρόσβαση στο εργαλείο οπτικοποίησης από τη σελίδα 
Investigate>Visualise  που προσφέρει μια σειρά τύπων σχεδίασης για διαφορετικούς τύπους 
ανάλυσης. Μερικά παραδείγματα για να δοκιμάσετε να χρησιμοποιήσετε το έργο επίδειξης 
περιλαμβάνουν:  

• Εργαλείο ημερολογίου

Επιλέξτε ένα κανάλι μέτρησης θερμοκρασίας από τη λίστα καναλιών. Στο ημερολόγιο κάτω από 
το γράφημα, επιλέξτε Ποιότητα.     ι (Quality). Οι μέρες εντός του ημερολογίου θα έχουν χρωματική 
κωδικοποίηση ώστε να εμφανίζουν ημέρες με υψηλή έναντι χαμηλής ποιότητας δεδομένων. 

• Χάρτες θερμότητας

Οι τύποι γραφημάτων μπορούν να αλλάξουν μέσω της καρτέλας "Settings" στη σελίδα 
Οπτικοποίηση. Μπορείτε να επιλέξετε πολλά κανάλια ταυτόχρονα χρησιμοποιώντας το 
πλήκτρο CTRL για καθέναν από τους διαθέσιμους τύπους γραφημάτων.  

4 PowerBI 
Για να δημιουργήσετε έναν χάρτη πορείας για την απαλλαγή από τις ανθρακούχες εκπομπές, 
μπορείτε να χρησιμοποιήσετε το Power BI. Το Power BI είναι βασικά ένα δωρεάν εργαλείο της 
Microsoft, αλλά το IES δημιούργησε ένα πρότυπο RPI για να δημιουργήσει ένα γράφημα που 
αντιπροσωπεύει τον χάρτη πορείας για την απαλλαγή ενός δήμου από τον άνθρακα.  



 STEP-WISE GA Ν. 101120859 ΣΕΛΙΔΑ 22 

ΟΔΗΓΙΕΣ ΧΡΗΣΗΣ ΤΗΣ ΤΕΧΝΙΚΗΣ ΕΡΓΑΛΕΙΟΘΗΚΗΣ 16.12.2024 - ΤΕΛΙΚΗ ΕΚΔΟΣΗ 

Τι συμβαίνει λοιπόν όταν εφαρμόζεται νέα μετασκευή σε όλα τα κτίρια; Τι συμβαίνει κατά την 
εφαρμογή ενός νέου συστήματος HVAC ή τι συμβαίνει κατά την εφαρμογή μιας συγκεκριμένης 
μετασκευής το 2023 το 2025; Για να χρησιμοποιήσετε το Power BI, χρειάζεστε δύο πρότυπα: 

• Πρότυπο χάρτη MS PowerBI IES, το οποίο είναι το περιβάλλον εργασίας.
• Πρότυπο χάρτη MS Excel IES, όπου μπορείτε να τοποθετήσετε τα δεδομένα που απαιτούνται

από το PowerBI.

Πρότυπο χάρτη MS PowerBI IES 
Έτσι, ξεκινώντας με το πρότυπο χάρτη πορείας MS PowerBI IES, μπορείτε να επιλέξετε τον δήμο στο 
περιβάλλον εργασίας. Αυτό συμβαίνει σε περίπτωση που μελετάμε περισσότερους δήμους. Έτσι, 
μπορείτε να επιλέξετε αυτό που σας ενδιαφέρει. Έτσι, έχετε κάποιες πληροφορίες υψηλού επιπέδου 
σχετικά με τους δήμους και τα τετραγωνικά μέτρα.  Εάν θέλετε να έχετε μια γρήγορη εικόνα του 
μοντέλου ICD, υπάρχει επίσης ένας σύνδεσμος που μεταφέρεται απευθείας στο διαδικτυακό 
μοντέλο. Επιστρέφοντας στον χάρτη πορείας, αναπτύξαμε δύο τύπους χαρτών πορείας: τον άνθρακα 
(CO2) και την ενέργεια. Έτσι μπορούμε να επιλέξουμε ένα από αυτά. Ξεκινώντας από την ενέργεια, 
δίνει στον δήμο MWh ανά έτος και πώς αλλάζει αυτή η παράμετρος, λαμβάνοντας υπόψη 
διαφορετικά σενάρια ενεργειακής απόδοσης για να ελέγξει την πρόοδο σε σχέση με αυτό που έχει 
προγραμματιστεί. Το ίδιο μπορεί να γίνει και για τον χάρτη πορείας για τον άνθρακα, αλλά σε αυτήν 
την περίπτωση, πρέπει να λάβουμε υπόψη τους παράγοντες απαλλαγής από τον άνθρακα. Έτσι, αν 
κάνετε κλικ στα διάφορα έτη, μπορείτε να δείτε τις τιμές των εκπομπών CO2, ποιες είναι οι εκπομπές 
CO2 χωρίς παρεμβάσεις και τη σωρευτική εξοικονόμηση CO2 που αναμένεται να επιτύχετε. Το 
πρότυπο χάρτη MS PowerBI IES συνδέεται με ένα υπολογιστικό φύλλο (πρότυπο χάρτη MS Excel 
IES). Έτσι, στο PowerBI, μπορείτε να κάνετε κλικ στην επιλογή "Transform Data" > "Data source 
settings" και να εισαγάγετε τη διαδρομή αρχείου όπου αποθηκεύεται το υπολογιστικό φύλλο. Έτσι, 
κάθε φορά που κάνετε αλλαγές στο υπολογιστικό φύλλο, πρέπει απλώς να κάνετε κλικ στο κουμπί 
"Refresh" και όλες οι διαφορετικές τιμές αποστέλλονται στο PowerBI. 

Πρότυπο χάρτη πορείας MS Excel IES 
Τώρα, λαμβάνοντας υπόψη το πρότυπο χάρτη πορείας MS Excel IES, όπως γράφεται στην εισαγωγή, 
δεν χρειάζεται να αγγίξετε τις πράσινες τιμές. Μην αλλάξετε τις κόκκινες τιμές. Πρέπει να αλλάξετε 
τα απαιτούμενα δεδομένα με μαύρο χρώμα σε κάθε υπολογιστικό φύλλο του αρχείου Excel 
σύμφωνα με τον εξεταζόμενο δήμο.  
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Λαμβάνοντας υπόψη το υπολογιστικό φύλλο επισκόπησης "Overview", το οποίο αφορά τη γραμμή 
βάσης, πρέπει να εισαγάγω το όνομα του κτιρίου, τον τύπο κτιρίου και την τοποθεσία. Σχετικά με 
τη συνολική επιφάνεια δαπέδου, μπορώ να το δω απευθείας στο iCD. Έτσι, αν κάνω κλικ στο IES 
ICD > reports > ready-to-make reports > site report > full site report, το λογισμικό δείχνει την 
ακαθάριστη επιφάνεια δαπέδου. Στη συνέχεια, το λογισμικό απαιτεί το Total Electricity και το Total 
Natural Gas. Αυτά τα δεδομένα μπορούν να βρεθούν στην Ενεργειακή Έκθεση του βασικού 
μοντέλου iCD. Επιπλέον, ο πίνακας απαιτεί το γεωγραφικό πλάτος και μήκος του τόπου (δεδομένα 
που μπορείτε να βρείτε στο Google Earth). Στη συνέχεια, στο "URL image" είναι δυνατή η εισαγωγή 
μιας εικόνας του μοντέλου iCD. Έτσι, αυτό που πρέπει να κάνω είναι απλώς να τραβήξω μια 
φωτογραφία. Ένα άλλο σημαντικό υπολογιστικό φύλλο του προτύπου χάρτη πορείας MS Excel IES 
είναι οι "CO2 emission factors", όπου πρέπει να ενημερώσετε τους συντελεστές εκπομπών CO2 
ηλεκτρικής ενέργειας και φυσικού αερίου ανάλογα με την τοποθεσία και την πρόοδο που 
προβλέπεται ανά έτος. Τέλος, έχουμε το υπολογιστικό φύλλο "P3 - Decarbonisation pathways", 
όπου συμβαίνουν οι περισσότερες αλλαγές. Στη στήλη "date", είναι δυνατόν να υποδείξετε πότε 
εξετάζονται μελλοντικά σενάρια. Στη συνέχεια, υπάρχουν οι στήλες Ηλεκτρισμού και Φυσικού 
Αερίου. Από αυτά, υπολογίζεται αυτόματα η συνολική ενέργεια και οι εκπομπές CO2, λαμβάνοντας 
υπόψη και τους συντελεστές εκπομπών CO2 για τις τελευταίες. Στη συνέχεια, υπάρχει μια στήλη 
σχετικά με τα "Implemented scenarios" στα οποία είναι δυνατή η εισαγωγή της τιμής-στόχου των 
εκπομπών CO2 για κάθε έτος. Επιπλέον, υπάρχει μια στήλη "Παρέμβαση" όπου τοποθετούνται οι 
εξεταζόμενες παρεμβάσεις (π.χ. ανακαίνιση κατοικιών, φωτοβολταϊκά, ηλεκτρικά οχήματα κ.λπ.). 
Τέλος, υπάρχει η στήλη «Roadmap type», η οποία είναι «carbon» ή «energy», προκειμένου να 
καταστεί δυνατή η επιλογή διαφορετικών χαρτών πορείας. Σημειώστε ότι για τις σειρές Energy 
Road Type, στη στήλη εκπομπών CO2 θα έχουμε τις τιμές Total Energy σε MWh/έτος 


